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Customer Templates  
A customer order template is a list of products that a customer orders regularly, such as wine 

lists for restaurants, or spare-parts lists for customer machinery. Each template is created for a 

selected ship-to address, and an unlimited number of templates can be created for each 

address.  

Once created, order templates can be used as lookups during sales transaction entry by 

accessing the Template Select window. The Template Select window also displays the 

history of orders placed for a selected item - i.e., quantities, price, order numbers, and dates. 

The main features of the Trinity Customer Templates module are: 

• The facility to set up customer order lists, based on historical data if required 

• The facility to update order templates automatically 

• Template lookup in sales order entry enables rapid selection of items 

• The facility to restrict customers to purchase items from a specified template 

• The facility to purge templates of unrequired items 

• The facility to copy template details 

• The option to base template history on sales orders or invoices 

• Generate a template history option to generate templates from customers’ historical data 

• The facility to create templates from Extended Pricing price sheets 

A default template can be selected for individual customer ship-to addresses if required in the 

Default Template Extras window. One template per customer ship-to address can also be 

selected as the historical template in the Template Maintenance window. This template is 

automatically updated with any new items ordered by a customer during order entry. All 

other templates are fixed templates and can only have items added or removed in the 

Template Maintenance window. 

Templates can be copied using the Template Copy window. Alternatively, they can be 

generated from historical data using the Generate Template History window or from 

Microsoft Dynamics™ GP Extended Pricing price sheets using the Price Sheet Template 

Creation window. Historical information is updated for each customer regardless of whether 

order templates have been created, and can be displayed directly in the Order History 

window. Template details for a selected customer range can be printed from the Template 

Report window. 

Purge facilities allow the removal of historical records. Use the Template Purges window to 

delete template items from a historical template that have not been ordered since a specified 

date, and to delete order history that is older than a specified date.  

Sales Information window 
The Sales Information window provides item search facilities when using Sales Transaction 

entry. 

A search string can be entered in the Sales Transaction Entry item number field; matching 

items are then displayed in the Sales Information window. 

Fields that can be searched include Item Number, Item Description, Generic Description, and 

Class ID. 

The Sales Information window can also be used to display customer templates. 
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An item can be selected from the list displayed in the Sales Information window and added to 

the current sales document. 

After a sales document line has been entered, there is an option for the user to return 

automatically to the item list on the Sales Information window, allowing rapid entry of a list 

of items into a sales document. 

More information about an item is displayed in the detail section of the Sales Information 

window. This data includes available inventory, selling price, margin, and sales pattern. 

 

Setup 

1. Template Setup Window 

Tools >> Setup >> Trinity >> 

Templates/TurboSOP >> 

Template Setup 

Use the Template Setup window 

to: 

• Set up template parameters 

 

 

The update template history settings on this window are especially useful if you enter sales 

documents directly as fulfillment orders/invoices rather than as orders. 

Note that sales orders are the default parameter for the Customer Templates module. If you 

want historical templates to be based on sales orders, and have not already set the parameter 

to base them on fulfillment orders/invoices, then you do not need to adjust the setting in this 

window. 

 

1.1 Setting up Template Parameters 

To set up Template parameters: 

1. If you require the facility to override restricted agreement templates (see Setting Template 

Defaults for Customers), then enter a password. 

If a customer is on a restricted agreement template, items not on the template cannot be 

entered into sales transactions for the customer. You can set up a password here so that if 

a non-template item is entered into a sales transaction for a customer on a restricted 

agreement template, then you are given the option to enter the password. If the correct 

password is entered, the item is accepted into the transaction. 

If no password is entered, then restricted agreement templates cannot be overridden. 

2. Under Update Template History From, click to select either Sales Orders or Fulfilment 

Orders/Invoices. 

Your selection sets the parameters upon which historical templates are based. For 

example, if you select Fulfilment Orders/Invoices, then historical templates are based on 

Sales Fulfilment Orders/Invoices rather than Sales Orders.  
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3. Click the Show Price in Template Select option to display the most recent price an item 

has been sold to the customer at on the Template Select window. 

4. Select the Open Sales Item Detail on Auto-Open Template option if you would like the 

Sales Item Detail Entry window to open automatically when the Template Select window 

is auto-opened (see Setting Template Defaults for Customers ). 

5. Click OK.  

Note that you can click Cancel at any point before clicking the OK button to close the 

Template Setup window. 

 

2. Sales Information Defaults window 

Tools >> Setup >> Trinity>> Templates/TurboSOP >> Sales Information Defaults 

Use the Sales Information Defaults window to: 

• Specify options for using the Sales Information window 
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2.1 Setting up Sales Information defaults 

To setup Sales Information defaults: 

1. Choose to set up General defaults for all users or to set up values for a specific 

user. The General options are used for any user who does not have their settings. 

2. Click Maintain Defaults. Any existing values are displayed. 

3. Select the option Activate Sales Information window to use the Sales Information 

window from within Sales Transaction Entry. If this option is selected, when 

CTRL-L is used in the item number field in Sales Transaction Entry, the Sales 

Information window is used to search for items instead of the Item lookup 

window.  

 

Note that the remaining options may be set up without marking the option 

Activate the Sales Information window, but only apply when the window is 

active. 

4. Select the option Automatically Return to Sales Information Window on Entry of 

a Line if you would like to return to the Sales Information window after each line 

is completed when entering document lines in Sales Transaction Entry.  

5. The option Use Sales Information Window as Template Selection Window works 

in conjunction with Default Template functionality. If a customer has a default 

template ID selected in the Default Template Extras window, and the Auto-Open 

Default Template option has been chosen, the Default Template is displayed in the 

Sales Information window instead of in the Template Select window. 

6. Select the option Show Promotional Price Flag in the Scrolling Window if you 

would like items on promotion to be indicated with an icon on the Sales 

Information window. Note that your item search runs more slowly if this option is 

chosen. 

7. If you use the Trinity Item Lifecycle module, you can omit any items marked as 

Do Not Sell by selecting the Exclude if Flagged as Do Not Sell option. 

8. Select Include Inactive Items if you would like to include items marked as 

inactive in the Item Maintenance window in your search. 

9. Select one of the following options from the Quantity Filtering dropdown: 

All Display all items regardless of stock 

balance 

Only if Available Qty > 0 Only show items which have a quantity 

available 

Only if Available + On Order Quantity 

> 0 

Only show items for which the total of 

(available quantity + quantity on 

purchase order) > 0 

 

10. Show the default value for the maximum number of items to be selected in the 

Sales Information window in the Maximum Items field. 

11. Under Item Inquiry Options, choose the fields that you would like to see in the 

detail section of the Sales Information window. 
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Cards 

3. Template Maintenance Window 

Cards >> Trinity>> Templates 

>> Maintenance 

Use the Template Maintenance 

window to: 

• Create and edit templates 

 

 

 

 

 

 

 

 

 

 

3.1 Creating and Editing Templates 

To create or edit a template in the Template Maintenance window: 

1. Enter a Customer ID or click the Customer ID lookup to select one from the Customers 

and Prospects window. 

2. Enter a Ship-to address or click the Ship-to lookup to select one from the Addresses 

window. 

3. Enter a Template ID to identify your template, or click the lookup to select one from the 

Template Lookup window. If you select an existing template, its details are displayed in 

the scrolling window.  
 

Click the Show button to display item descriptions. 
 

4. Enter a Template Description to describe your template. 

5. Select the Update From Sales Transaction Entry checkbox if you want this template to be 

the historical template. 

6. Select the Resequence on Retrieval checkbox if you want sequence numbers to be 

automatically regenerated each time the template is loaded into Template Maintenance. 

Sequence numbers are required for each item on a template and can be entered by the user or 

automatically generated by the system. They provide an alternative method of sorting the 

template within order entry, such as sorting wine lists by bin number. 
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7. Enter an Item Number or click the lookup to select one from the Items window. Repeat 

for each item to be added to the template. 

8. Enter a new Seq. No. for each item on the template or accept the system defaults. 

9. Click Save to save your template.  

 

Click the Delete button to remove a template. 

 

4. Default Template Extras Window 

Cards >> Trinity>> Templates >> 

Default Extras 

Use the Default Template Extras 

window to: 

• Restrict a customer to purchasing 

items from a specified template 

• Set a default template for a 

customer/address combination 

Note that the Default Template Extras 

window is also available as an 

Additional option from the Customer 

Maintenance window. 

 

4.1 Setting Template Defaults for Customers 

To set template defaults for customers in the Default Template Extras window: 

1. Enter a customer ID or select one using the lookup. 

2. Enter an address ID or select one using the lookup or browse buttons. 

3. Enter a template ID or select one using the lookup. The selected template ID is the default 

template for the displayed customer/address combination. 

4. Click the Restricted Agreement option to limit the selected customer/address combination 

to purchasing items from the selected template only. 

5. Click the Auto-Open Default Template option to cause the Template Select window to 

open automatically displaying the selected template ID when entering items into a sales 

transaction for the selected customer/address combination. 

 

If the “Open Sales Item Detail on Auto-Open Template” option has been selected in the 

Template Setup window (see Template Setup), the Sales Item Detail Entry opens at the 

same time as the Template Select window auto-opens. 

6. Click Save to save the settings and close the window. 

Click Delete to delete default template settings. 
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5. Template Copy Window 

Cards >> Trinity>> 

Templates >> Copy  

Use the Template Copy 

window to: 

• Copy templates to other 

addresses or other 

customers 

 

 

 

 

5.1 Copying Templates 

To copy a template report in the Template Copy window: 

1. Enter a Customer ID or click the lookup to select a Customer ID from the Customers and 

Prospects window. 

2. Enter an Address ID or click the lookup to select an Address ID from the Addresses 

Lookup window for the selected Customer. 

3. Enter a Template ID or click the lookup to select a Template ID from the Template lookup 

window. You can also use the browse buttons to move between Template IDs. 

Note that if you have set the Template to be a Historical Template, then the Historical 

Template checkbox is highlighted. 

4. Click to select whether you want to copy the selected template to Other Addresses for 

Customer or Other Customers. 

5. If you select Other Addresses for Customer, you should then enter From and To Addresses 

or click the lookups to select addresses from the Addresses Lookup window. 

6. If you selected Other Customers, enter From and To Customers or click the lookups to 

select Customers from the Customers and Prospects window. 

Note that this copies the selected template to all addresses held for the selected Customer 

range. To apply the template copy to the Primary Ship-To Address only, click the Primary 

Ship-To Address Only checkbox. This field only displays if you selected the Other Customers 

option. 

7. For Copy Mode, click to select Add Items to Template or Overwrite Existing Template. If 

you select to Add Items to Template, any items new to the address or customer are added to 

their existing template. 

If you select to Overwrite Existing Template, any templates already held for selected 

Customer/address combinations are overwritten in full, and the Customer/address 

combination is assigned the full template. 

8. Click the Copy button to apply the template copy selections that you have made. 
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Note that you can click Cancel at any point before clicking the Copy button to close the 

Template Copy window. 

 

Enquiries and Reports 

6. Sales Information Window 

Sales Transaction Entry >> Item 

number field >> CTRL-L  

Use the Sales Information window to:   

• Search for and select items 

during sales transaction entry 

• View item details such as price, 

margin and available inventory 

during sales transaction entry 

 

 

 

 

 

6.1 Using the Sales Information window 

To use the Sales Information window during sales transaction entry: 

1. The Activate Sales Information window option must be enabled in the Sales Information 

Defaults window to use the Sales Information window in Sales Transaction Entry.  Once 

this option has been enabled, using CTRL-L on the Item Number field in Sales Transaction 

Entry opens the Sales Information window instead of the Item lookup. 

2. If you enter CTRL-L on an empty item number field, your cursor moves to the Search field 

on the Sales Information window, and you can enter search parameters as required. 

3. If you enter a search string and press CTRL-L, the system performs an Item Search using 

your search string in conjunction with the search parameters already selected in the Sales 

Information window.  If the search finds a single item number, this is returned to the Sales 

Transaction Entry item number field. If multiple item numbers are identified in the search, 

these are displayed in the Sales Information window, from where you can select the item 

that you require. 

4. To return from the Sales Information window to Sales Transaction Entry, press ESC. 

5. To disable the Sales Information window to use the Item lookup, use the Sales Information 

Window Active setting under the Options menu. If you wish to select items from the Item 

Catalog (Catalog Based Sales module) or the Template Select window, it is advisable to 

disable the Sales Information window. 

6. The detail section of the Sales Information window shows further information about either 

the item currently highlighted in the Sales Information scrolling window or the item on the 

current Sales Transaction line. The fields displayed are those specified in the Sales 

Information Defaults window. 
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7. Use the buttons in the detail section to retrieve additional item information. Note that these 

options are only available if the appropriate software module has been installed. 

 Open item notes 

 
Open Inventory Available to 

Promise Inquiry 

 
Open Aggregate Promotion inquiry 

window 

 
Open Order History inquiry 

window 

 Open Price Trace window 

 Open Quantities by Site window 

8. After entry of each line on the sales document, the user is returned to the Sales Information 

window to select another item if the Automatically Return to Sales Information Window 

option is set in the Sales Information Defaults window. 

 

Using the Search parameters in the Sales Information window: 

1. From the Search dropdown menu, choose to Search on Item Number, Item Number & 

Description, Item Description, Generic Description, Short Description, Item Class, or Class 

Description. Then choose to search whether your selected field contains or begins with 

your search string. 

2. Enter a search string. Note that you can enter multiple strings separated by a “+” sign. For 

example, searching for “ch+ay” would search for items containing the strings “ch” and 

“ay.”  

3. When you tab off the search string field, the scrolling window is populated with the search 

results. 

4. Highlight an item in the scrolling window to show more information about the item in the 

detail section of the window. The fields displayed are those specified in the Sales 

Information Defaults window. 

5. Click Select or press enter to choose an item from the scrolling window to be entered into 

your Sales Transaction. 

6. Click Clear to clear your search string. 

7. Note that the Site ID takes its value from the Default Site ID on the Sales document. The 

item search is restricted to items that are linked to the selected site. Change the Site ID to 

All Sites to show items across all sites. 

8. The default value for the maximum number of items to be selected in the search can be 

specified in the Sales Information Defaults window. This value can be changed at runtime 

by changing the Maximum Items field. 

9. Default values for the Item Quantity filter and the Exclude if Flagged as Do Not Sell option 

can be specified in the Sales Information Defaults window. These values can be changed at 

runtime by selecting options in the View dropdown menu of the scrolling window. 

10. The Include Inactive Items setting is adjusted using the Options menu. 
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Using the Sales Information window as the Template Selection window: 

1. You can view a customer template in the Sales Information window by selecting a 

Template ID. If a Template ID is selected, the item search is restricted to items on the 

selected template. 

2. The customer’s default template can be displayed automatically in the Sales Information 

window. To do this:  

− set the Use Sales Information window as Template Selection window option in the 

Sales Information Defaults window. 

− set up a default template for the customer and ship-to address in the Default 

Template Extras window, and mark to Auto-Open Default Template.  

When entering a sales document for this customer and ship-to address, the Sales 

Information window opens automatically with the customer’s default template displayed. 

 

7. Template Select Window 

Inquiry >> Trinity>> 

Templates >> Template 

Select 

Use the Template Select 

window to:   

• Select template 

items during sales 

transaction entry 

• View order history 

Note that the Template 

Select window can also 

be opened from the Sales 

Transaction Entry 

window – choose 

Template Select from the 

Additional menu.  

 

 
 

If you selected the Auto-Open Default Template option in the Default Template Extras 

window, the Template Select window open when entering items into sales transactions.  The 

window displays the selected default template for the customer/address combination unless the 

Sales Information window is used for this.  
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7.1 Selecting Template Items During Sales Transaction Entry 

An order template can be used as a lookup during sales transaction entry. 

Note that you can click the Stop Auto Open button to close the Template Select window for the 

duration of the current transaction. 

To look up a template during sales transaction entry in the Template Select 
window: 

1. Start to enter your sales document details in the Sales Transaction Entry window. Once you 

have selected a Document No. and a Customer ID, the Template Select window becomes 

available to use. 

2. Select Template Select from the Additional menu. 

3. The Template Select window opens, showing the current Customer ID selection and default 

Ship-To address, Template ID entries, and Currency ID. Accept these settings or make new 

selections. 

4. Each template item is displayed in the Items scrolling window. The Unit Price for each 

item is the price that is applied to the item in sales transaction entry, whether you are using 

standard pricing or Extended Pricing. The Quantity Ordered is the quantity on the current 

sales transaction.  

Click the Refresh button to refresh this quantity. 

You can also click the Only Show Item Not Yet Ordered option to only display items not 

yet added to the current sales transaction. 

5. If you want to select multiple items from the template, click the Push Pin button to keep the 

Template Select window open after each selection. For each item to be selected: 

a. Highlight an item or click Find to locate one in the Find Item window. 

b. Click the Select button to return the selected item to the sales transaction. 

6. Enter the remaining transaction details in the usual way. 

If the customer/ship-to address has a historical template, it is updated with any new items when 

you create and save an order. You are given the option to create a historical template 

automatically when you first create an order for a new ship-to address. 

 
7.2 Viewing Order history 

When selecting template items during sales transaction entry, the lower half of the Template 

Select window displays the order history for a selected template item. 

To view the order history of an item in the Template Select window: 

1. Highlight an item in the Items scrolling window. 

The Item History scrolling window displays any past orders associated with the selected 

item. For each order, the order date, order number, unit of measure, quantity, and price 

are shown. If you are also using the Trinity Catchweights module, the Catchweight Units 

of Measure and listed quantities are also be displayed in the Item History scrolling 

window.  

2. To view an order in more detail: 

− Highlight an order in the Item History scrolling window or click the Find button to 

locate one in the Find History window. 

− Click the Order Number zoom. The Order History window opens. 
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8. Order History Window 

Inquiry >> Trinity>> 

Templates >>Order 

History 

Use the Order History 

window to:  

• View historical 

orders 

 

Note that the Order 

History window can also 

be opened by clicking 

the Order Number zoom 

in the Template Select 

window. 

 

 

 

8.1 Viewing Historical Orders 

To view historical orders in the Order History window: 

1. When called from the Template Select window, the Order History window opens, 

showing the current Customer ID, Ship-to address, and Document No. selection. Accept 

these settings or make a new selection. 

2. Each item in the order is displayed in the scrolling window. The item number, unit of 

measure, quantity, and price is listed for each item.  

 

Click the Show button to display the item description and extended price. 
 

Note that if you are using the Trinity Catchweights module, clicking the Show button 

displays Catchweight Units of Measure and quantities for the listed orders. 

              

9. Template Report Window 

Reports >> Trinity>> 

Templates >> Report 

Use the Template Report 

window to:  

• Print template 

details for a range of 

customers 
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9.1 Printing Template Details 

To print a template report in the Template Report window: 

1. Enter a From Customer ID or click the lookup to select one from the Customers and 

Prospects window. 

2. Enter a To Customer ID or click the lookup to select one from the Customers and Prospects 

window. 

To print a single template, select Print from the File menu when the template is displayed in 

the Template Maintenance window. 

 

Routines 

10. Template Purges Window 

Tools >> Routines >> Trinity>> 

Templates >> Purge 

Use the Template Purges window 

to: 

• Remove items that have not 

been ordered since a specified 

date from a historical template 

• Remove order history older than 

a specified date 

 

 

 

10.1 Removing Historical Information 

To remove historical items and order history in the Template Purges window: 

1. Select All to purge all customer details, or select From to purge a range of customer details. 

If you select From, enter to and from Customer IDs to specify a range, or use the lookups. 

2. Select the Items in historical templates checkbox or the Purge History checkbox to remove 

items from historical templates or purge history, or do both. 

3. Enter a Purge Date. 

4. Click the Purge button. 

History older than the entered date is deleted. 
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11. Generate Template History Window 

Tools >> Routines >> 

Trinity>> Templates >> 

Import 

Use the Generate Template 

History window to: 

• Generate historical 

templates for selected 

orders 

This will be particularly useful 

if you want to create historical 

templates for customers whose 

sales orders were created 

before you set up the 

Customer Templates module. 

 

11.1 Generating Historical Templates for Selected Orders 

To generate historical templates for selected orders in the Generate Template 
History window: 

1. Enter the Start Date from which you want a historical template to be generated. All orders 

(i.e., not quotes, returns, or invoices) placed from that date to present are included on the 

historical templates for your selected range. These orders must have a Ship-to Address 

specified, or a template is not created. 

Note that the Start Date default initially displayed in the window is three months before the 

current date. 

Any Customer/Address combination for which you have previously specified that a 

historical template isn’t required is omitted from processing. Enter a Customer From and 

To range or use the lookups to select Customers from the Customers and Prospects 

window. You can click All to select all Customers. 

2. Enter a Class ID From and To range or use the lookups to select Class ID’s from the 

Customer Classes window. You can click All to select all Class IDs. 

Note that if you include a Customer in the range that has a Class ID not included in the 

range (or no Class ID), then this Customer is not included in the processing selection. 

3. Click Process to create historical templates for your selection. 

Note that you can click Cancel at any point before clicking the process button to close the 

Generate Template History window. 
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12. Price Sheet Template Creation Window 

Tools >> Routines >> 

Trinity>> Templates >> 

Price Sheet Template 

Use the Price Sheet 

Template Creation window 

to: 

• Create templates from 

Extended Pricing Price 

Sheets 

 

Note that this window is 

only available if you are 

working with Extended 

Pricing in Microsoft 

Dynamics™ GP. See the 

Microsoft Dynamics™ GP 

User Manuals for further 

information on working 

with Extended Pricing. 

 

12.1 Creating Templates from Extended Pricing Price Sheets 

To create templates from Extended Pricing price sheets in the Price Sheet 
Template Creation window: 

1. Enter the Price Sheet ID on which you want to base a template, or select one using the 

lookup. 

2. Enter a Template ID and Template Description for the new template that you want to 

create.  

Note that you can enter a currently existing template - see the Copy Mode options for 

further details. 

3. The Update from Sales Transaction Entry checkbox allows you to set templates created in 

this window as historical templates for the selected customer range. Select this option to set 

the template as a historical template. 

Note that where any customers in the selected range already have a historical template, the 

template created here is assigned to them as a standard template. Details are printed in the 

Template Creation from Price Sheet report that is printed automatically at the end of 

window processing. 

4. Enter the customer range that you want to assign the template to, or select a customer range 

using the lookups. 

5. Alternatively, select a price book ID.  The template is then assigned to all customers that 

have been linked to the selected price book. 

6. Click the Primary Ship-to Address Only option to assign the template to the Primary Ship 

Address only for the selected customer range. Not selecting this option results in the 

template being assigned to all addresses for the selected customers. 
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7. You have two options under Copy Mode.  These options apply if you have selected an 

existing template as your Template ID. 

Add Items To Template 

Items from the price sheet not 

currently on the template are added to 

the template 

Overwrite If Existing Template 
The template is overwritten in its 

entirety with items on the price sheet 

Click to select the option you require. 

8. Click Copy to copy details from the price sheet to the template for selected customers.  

Note that you can click Cancel at any point before clicking the Copy button to close the Price 

Sheet Template Creation window. 
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Appendix A 

Customer Templates – Access to Windows 

Window Name  Menu Access  Other Access 

Default Template 

Extras 

Cards >> Trinity>> Templates >> 

Default Extras 

Cards >> Sales >> Customers 

>> Additional >> Default 

Temp. Extras 

Generate 

Template History 

Tools >> Routines >> Trinity>> 

Templates >> Import 

 

Order History Inquiry >> Trinity>> Templates >> 

Order History 

Sales Transaction Entry 

window >> Additional >> 

Order History Lookup 

Price Sheet 

Template 

Creation  

Tools >> Routines >> Trinity>> 

Templates >> Price Sheet Template 

 

Sales 

Information 

Defaults 

Tools >> Setup >> Trinity >> 

Templates/TurboSOP >> Sales 

Information Defaults 

 

Sales 

Information 

 Sales Transaction Entry >> 

Item number field >> CTRL-L 

Template Copy Cards >> Trinity >> Templates >> 

Copy 

 

Template Setup  Tools >> Setup >> Trinity >> 

Templates/TurboSOP >> Template 

Setup 

 

Template 

Maintenance 

Cards >> Trinity >> Templates >> 

Maintenance 

 

Template Purges Tools >> Routines >> Trinity >> 

Templates >> Purge 

 

Template Report Reports >> Trinity >> Templates >> 

Report 

Template Maintenance window 

>> File >> Print (once a valid 

template has been selected) 

Template Select Inquiry >> Trinity >> Templates >> 

Template Select 

Sales Transaction Entry or 

Sales Item Details Entry 

windows >> Additional >> 

Template Select 
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Appendix B 

Customer Templates - Reports 

Report Name Module Functionality 

Sales Transaction 

Templates report 

Template Selling Select a range of templates in the Template 

Report window and print report 

Individual templates can be reported on 

through the Template Maintenance window 

Template Copy 

Audit report 

Template Selling Prints details of processing performed through 

the Template Copy window 

Template 

Creation from 

Price Sheet report 

Template Selling Prints details of processing performed through 

the Price Sheet Template Creation window 
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Appendix C 

About Trinity 

Help >> About Microsoft Dynamics GP >> Additional >> About Trinity Suite 

Use the About Trinity Suite window to check your registration information and installation 

details. The window tells you which Trinity modules you are registered to use and which 

have been installed on your system. 

 

 
 


